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The Rack in Detail  

The Rack Control Strip 

 

At the top of each Rack there is a

assign it to processing groups. The control strip has the following windows and buttons:

 

 

In/Out  Disables the Rack’s plug

Rack 

comparison or to 

Mute Silences the Rack, but doesn’t remove it from CPU processing. 

Muting is performed on the Rack’s input to allow reverb tails and 

delay taps to fade gracefully.

Rack Name  

 

Displays the Rack’s name 

Setup > Audio I/O

I/O ports will show on the right, rename a waves port to change the 

name of the 

 

Group Name  

(“Drums” in this 

example) 

Refers to 

been assigned. Use the pull

another 

 

 

 

 

 

  

 

there is a control strip allowing you to control the Rack and 

assign it to processing groups. The control strip has the following windows and buttons:

Disables the Rack’s plug-ins and passes the signal directly from 

Rack input  to Rack output . Typically used for “before and after” 

comparison or to bypass processing. 

Silences the Rack, but doesn’t remove it from CPU processing. 

Muting is performed on the Rack’s input to allow reverb tails and 

delay taps to fade gracefully. 

splays the Rack’s name given by matching I/O Port. 

Setup > Audio I/O . Select Waves in the left column, all available 

I/O ports will show on the right, rename a waves port to change the 

name of the matching rack. 

Refers to a latency alignment group to which the Rack 

been assigned. Use the pull-down menu to assign the Rack to 

another latency group. 

he Rack and 

assign it to processing groups. The control strip has the following windows and buttons: 

 

ins and passes the signal directly from 

. Typically used for “before and after” 

Silences the Rack, but doesn’t remove it from CPU processing. 

Muting is performed on the Rack’s input to allow reverb tails and 

I/O Port. Touch 

Select Waves in the left column, all available 

I/O ports will show on the right, rename a waves port to change the 

to which the Rack may have 

down menu to assign the Rack to 



Selecting Racks and Using Keystroke Commands:

Using a mouse, right click on the top part of a 

down menu that offers several functions:

 

 

Active(On) 

Bypass 

Mute 

Global Paste Rack 

Recall Safe 

Selecting Racks and Using Keystroke Commands:  

Using a mouse, right click on the top part of a selected Rack and you will see a pull

down menu that offers several functions: 

The Rack is always active. 

Disables the Rack’s plug-in processing and passes 

signal from the Rack input to the Rack output.

Mutes the entire Rack but doesn’t remove plug

CPU. 

Copies the Rack’s parameters from the recalled Snapshot 

and pastes them into the selected Snapshots 

“Global Paste” is selected in the Snapshot Pane. 

example, if your singer has a cold and 

vocals differently, Global Paste allows you to change 

specific settings, then embed these parameter changes 

into all of the Snapshots you’ve made, rather than having 

to adjust each Snapshot separately. The Global Paste 

function is discussed in detail in the “Snapshots” section 

of this manual. 

Places the selected Rack or plug-in into a “safe” mode 

which protects it from Snapshot recalls. 

racks or plug-ins are unaffected by all Snapshot recalls, 

even if a Snapshot has parameters that 

changed on Snapshot recall. This command is allowed 

only when "Recall Safe" Mode is selected in the 

Snapshots menu. 

selected Rack and you will see a pull-

in processing and passes the 

Rack output. 

but doesn’t remove plug-ins from 

Copies the Rack’s parameters from the recalled Snapshot 

and pastes them into the selected Snapshots where 

“Global Paste” is selected in the Snapshot Pane. For 

example, if your singer has a cold and you need to EQ the 

vocals differently, Global Paste allows you to change 

specific settings, then embed these parameter changes 

into all of the Snapshots you’ve made, rather than having 

The Global Paste 

sed in detail in the “Snapshots” section 

in into a “safe” mode 

protects it from Snapshot recalls. "Recalled Safe" 

ins are unaffected by all Snapshot recalls, 

ot has parameters that "should" be 

This command is allowed 

Mode is selected in the 



Assign the Rack to a latency 

alignment group 

Presents a list of available latency alignment groups from 

which you can assign a latency group/s to a rack/s. 

 

Latency Displays the Rack’s overall latency (accumulated inserted 

plug-in latencies) 

CPU Consumption Displays the Rack’s CPU consumption (usage) on the 

SoundGrid Server and the core it runs on 

 

Input and Output Sections 

 

To the right of the Input Rail is the Input Audio Fader, with a range of 

±18dB.  

On the far right side of each Rack are the Output Rail and the Output 

Audio Fader. Rack audio input and output levels are stored within 

Snapshots. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



Adding Plug ins to a Rack

 

To add a plug-in to a Rack, touch the “

Select a plug-in from the pull-down menu. An icon representing the plug

on the Rack, along with a new 

the right of the existing one.  

Signal flow within a Rack is always from left

While in the Main view (or Rack view), you can always change the plug

within a Rack by grabbing a plug

icon has an "In" switch that bypass

Rack. There is also a level meter on the icon that shows plug

 

 

 
 
 
 
 
 
 
 
 

 

 
 
 
 

ins to a Rack  

in to a Rack, touch the “plus ” (+) sign to the right of the Input Fader. 

down menu. An icon representing the plug-in will appear 

on the Rack, along with a new “plus ” (+) sign that you can touch to add a new plug

 

low within a Rack is always from left-to-right.  

While in the Main view (or Rack view), you can always change the plug-in sequence 

within a Rack by grabbing a plug-in and dragging it to the desired location. Each plug

bypasses the processor without disengaging it from the 

Rack. There is also a level meter on the icon that shows plug-in output level. 

 

) sign to the right of the Input Fader. 

in will appear 

that you can touch to add a new plug-in to 

in sequence 

in and dragging it to the desired location. Each plug-in 

processor without disengaging it from the 

in output level.  



Rack View: Controlling

 

Double touch a plug-in's icon to open its interface and enter MultiRack SoundGrid’s 

Rack View.  

 

 

Here you can adjust each plug

using the Touch-n-Turn knob or toggle to set the selected parameter. Some controls on 

selected plugins might appear too small for touch selection 

keyboard with mouse for more precise operation. If you’re already familiar with Waves 

plug-ins, this window will be very easy to use. 

 

 

At the top of each plug-in window is a 

compare processor settings. The layout of the 

one plug-in to another. Use this toolbar to save plug

 

 

Controlling  Your Plug-ins 

s icon to open its interface and enter MultiRack SoundGrid’s 

adjust each plug-in parameter by selecting the parameter on screen and 

Turn knob or toggle to set the selected parameter. Some controls on 

selected plugins might appear too small for touch selection - please use Digico's 

se for more precise operation. If you’re already familiar with Waves 

ins, this window will be very easy to use.  

window is a WaveSystem Toolbar , used to load, save, and 

compare processor settings. The layout of the WaveSystem Toolbar  may vary from 

in to another. Use this toolbar to save plug-in or Rack-specific presets.

s icon to open its interface and enter MultiRack SoundGrid’s 

 

in parameter by selecting the parameter on screen and 

Turn knob or toggle to set the selected parameter. Some controls on 

please use Digico's 

se for more precise operation. If you’re already familiar with Waves 

, used to load, save, and 

may vary from 

specific presets. 



There are several quick ways to move from one plug-in to another within a Rack: 

Use your keyboard’s left and right arrows. This will move you through the list of plug-ins 

in the Rack, opening each plug-in interface as it is selected. Note: If you have selected 

a parameter for editing on the current plug-in, this will not work, and may change the 

parameter value instead. 

Touch another plug-in icon. This will move you directly to the new plug-in and open its 

window. 

 

 

 

 

  

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



WaveSystem Toolbar Buttons

Setup A (Setup B)  Toggles between two setups, allowing you to compare different 

settings. This facilitates quick A/B comparisons and lets you 

determine which of two settings works best without having to save a 

preset. An asterisk (*) on the button indicates that changes hav

made since a preset was loaded. 

A►B; B►A  Copies the current settings to the second setup register. The direction 

of copying is from the currently shown setup to the one not shown. 

Load  Here you load factory presets, user presets, and other preset files. 

Factory presets are permanent elements of the Load popup menu, 

created by Waves. They cannot be changed or deleted. You can turn 

the current settings of the plug

clicking the Save button. User presets can be changed and deleted, 

and the preset files you save through the toolbar will appear as Load 

menu presets until you close the preset file or close the plug

plug-ins have a very large library

the main pull

from external files, select “

saved with an .XPS extension 

Save  Save your plug

as a user preset in the Preset menu, or create a new file. If you 

choose to save the preset as a new file 

menu 

 Clicking on the Waves logo will 

page, providing information about the plug

 

 

WaveSystem Toolbar Buttons  

Toggles between two setups, allowing you to compare different 

settings. This facilitates quick A/B comparisons and lets you 

determine which of two settings works best without having to save a 

preset. An asterisk (*) on the button indicates that changes hav

made since a preset was loaded.  

Copies the current settings to the second setup register. The direction 

of copying is from the currently shown setup to the one not shown. 

Here you load factory presets, user presets, and other preset files. 

Factory presets are permanent elements of the Load popup menu, 

created by Waves. They cannot be changed or deleted. You can turn 

the current settings of the plug-in you’re using into a us

clicking the Save button. User presets can be changed and deleted, 

and the preset files you save through the toolbar will appear as Load 

menu presets until you close the preset file or close the plug

ins have a very large library of presets, too large to display on 

the main pull-down menu. To load these library files or load presets 

from external files, select “Open Preset File .” Waves preset files are 

saved with an .XPS extension  

Save your plug-in presets here. You can save the current parameters 

as a user preset in the Preset menu, or create a new file. If you 

choose to save the preset as a new file — outside the plug

menu — WaveSystem will ask you where you want to put it. 

Clicking on the Waves logo will bring up the “About This Plug

page, providing information about the plug-in. 

 

Toggles between two setups, allowing you to compare different 

settings. This facilitates quick A/B comparisons and lets you 

determine which of two settings works best without having to save a 

preset. An asterisk (*) on the button indicates that changes have been 

Copies the current settings to the second setup register. The direction 

of copying is from the currently shown setup to the one not shown.  

Here you load factory presets, user presets, and other preset files. 

Factory presets are permanent elements of the Load popup menu, 

created by Waves. They cannot be changed or deleted. You can turn 

in you’re using into a user preset by 

clicking the Save button. User presets can be changed and deleted, 

and the preset files you save through the toolbar will appear as Load 

menu presets until you close the preset file or close the plug-in. Some 

of presets, too large to display on 

down menu. To load these library files or load presets 

.” Waves preset files are 

ve the current parameters 

as a user preset in the Preset menu, or create a new file. If you 

outside the plug-in’s Preset 

WaveSystem will ask you where you want to put it.  

bring up the “About This Plug-in” 



Inserting a Rack into a channel

 

Below are two generic examples of how you can use Waves plug

an Insert and through an Aux.

 

Example 1:  Assigning Waves Plugins to a Channel Insert.

 

Open Channel view by pressing the console's “

Select the desired channel, then touch 

Touch Insert A  to open routing.

 

    >      >  

 

Set Routing: 

 

In the Ports  column, choose Waves

Choose the desired Signal Group

Under Signals , choose the desired 

 

a Rack into a channel  

Below are two generic examples of how you can use Waves plug-ins in your session, as 

an Insert and through an Aux. 

Assigning Waves Plugins to a Channel Insert. 

Open Channel view by pressing the console's “Screen Assign ” Left or Right button. 

Select the desired channel, then touch Insert  area to open sub-menu.  

to open routing. 

>   > 

Waves .  

Signal Group .  

, choose the desired Waves I/O . 

ins in your session, as 

” Left or Right button.  

 



Example 2:  Setting Rack as Parallel FX  

 

a) FX SEND. 

 

Open Master channel view by pressing the "Screen Assign"  on the console’s center  

section.  

Select the desired Master channel . In the below example we will set Mono Aux 1 .  

Touch Outputs  to open the routing panel.  

 

 >     >     >    

 

 

Set Routing: 

 

In the Ports  column, choose Waves .  

Choose the desired Signal Group.  

Under Signals , choose the desired Waves I/O . 



b) FX RETURN 

 

Open Channel view by pressing the console's “

Select the desired input channel for 

menu.  

In the Ports  column, choose Waves

Choose the desired Signal Group

Under Signals , choose the desired 

for the FX SEND). 

 

 

     >       

 

 

 

 

Open Channel view by pressing the console's “Screen Assign ” Left or Right button. 

Select the desired input channel for FX RETURN, then touch Input  area to open sub

Waves .  

Signal Group .  

, choose the desired Waves I/O  (the same Rack that has been assigned 

>           >   

” Left or Right button.  

area to open sub-

(the same Rack that has been assigned 

 



Rack types: Stereo, Mono, Mono to Stereo.

Similar to outboard gear, the Waves Racks are configured to work in different modes: 

Stereo processing: Stereo C

Ears etc… 

Mono processing : individual 

Mono to Stereo: Reverbs, D elays etc…

 

Waves Racks types and names 

Depending on type of input (mono or stereo) Waves will automatically load the correct 

Rack type. 

   

 

For Mono to Stereo configuration (

Rack types: Stereo, Mono, Mono to Stereo.  

Similar to outboard gear, the Waves Racks are configured to work in different modes: 

Channel Insert, Master Channel, Stereo Groups, 

: individual Mono Channels, Mono Aux EQ’s etc… 

elays etc… 

Waves Racks types and names are set via the Console’s routing: 

Depending on type of input (mono or stereo) Waves will automatically load the correct 

 

Mono to Stereo configuration (Reverb etc…) turn on mono>stereo button

 

 

Similar to outboard gear, the Waves Racks are configured to work in different modes:  

roups, Stereo In-

Depending on type of input (mono or stereo) Waves will automatically load the correct 

button 



Group Properti es: Organization & Latency 

This window allows you to group several Racks together. Racks often have something 

in common, and it may make sense to assign all of these similar Racks to a 

group. Grouping all of the channels of your brass section, or drums, or audience, then 

assigning these groups a color

Also, each track will display the name of the group, further aiding quick visual 

organization. 

 

 

Plug-ins may impose a delay (known as “latency”) as signal passes through them. 

Often, this is not a problem. However, there are times you will want to time

the Racks in a group, to compensate for different processor latencies that may cause 

phase-related problems.   

 

 

 

es: Organization & Latency Alignment

This window allows you to group several Racks together. Racks often have something 

in common, and it may make sense to assign all of these similar Racks to a 

channels of your brass section, or drums, or audience, then 

assigning these groups a color; helps you to keep track of racks in concert situations. 

Also, each track will display the name of the group, further aiding quick visual 

 

may impose a delay (known as “latency”) as signal passes through them. 

Often, this is not a problem. However, there are times you will want to time

the Racks in a group, to compensate for different processor latencies that may cause 

Alignment  

This window allows you to group several Racks together. Racks often have something 

in common, and it may make sense to assign all of these similar Racks to a latency 

channels of your brass section, or drums, or audience, then 

acks in concert situations. 

Also, each track will display the name of the group, further aiding quick visual 

may impose a delay (known as “latency”) as signal passes through them. 

Often, this is not a problem. However, there are times you will want to time-align all of 

the Racks in a group, to compensate for different processor latencies that may cause 



Use the Group Properties  window to create groups of 

Open this window from the pull

Window  menu. 

 

In the Group Properties  window, you can create up to 1

which can contain any number of Racks.

 

 

Create a group by double clicking on a 

to assign the group (using the external keyboard). Now, decide how you want to align 

the processors within the group. 

window to create groups of racks and align their latencies. 

Open this window from the pull-down menu located at the top of a rack or from the 

 

window, you can create up to 16 processing groups, each of 

which can contain any number of Racks. 

Create a group by double clicking on a Group Name  cell and typing the name you want 

to assign the group (using the external keyboard). Now, decide how you want to align 

the processors within the group.  

acks and align their latencies. 

ack or from the 

6 processing groups, each of 

 

cell and typing the name you want 

to assign the group (using the external keyboard). Now, decide how you want to align 



None A group is created, but there is no latency alignment. 

Auto The group is delayed to match the latency of the rack in the group with the 

greatest total latency. 

 

 

Manual Manually delay the group by a specific value by entering it in the Latency field. 

The value is displayed in samples, milliseconds, meters or feet, depending on 

your choice in the pull-down window. The minimal value allowed for this setting 

matches the latency of the rack in the group with the greatest total latency. 

 

 

Groups are color-coded for easier identification. Color selection is based on placement 

in the list, and is not user-definable.  

 

At the bottom of the Group Properties page is the Align All  section.  

 

 

 

Here you can align all of the groups of Racks in order to create a unified timing for all 

channels. The Auto setting will offset all of the groups to match the timing of the group 

with the greatest latency, while Manual  will delay all groups by a specific value.  

 

Below the Align All section is the “Speed of Sound” setting.  

 

 

 

This parameter control, expressed in meters per second, allows you to calibrate 

MultiRack SoundGrid’s latency controls to match measured speed of sound. The speed 

of sound at sea level, at a temperature of 20 degrees Celsius and dry air, is 343 meters 

per second.  



Snapshot Pane: Automatin

Snapshots contain the following parameters:

 

1. Rack input and output gain

2. Rack in/out, mute and on/off states

3. Current plug-in parameters

 

Snapshots are contained and saved as part of the Session file and are displayed as a 

vertical playlist. 

 

Use Snapshots to change the state of 

the settings for the plug-ins. Snapshots do not change the physical configuration of 

Session, so you cannot use a s

plug-ins embedded in a rack. 

 

To open the Snapshot Pane (fig. a), select 

menu (Ctrl+Shift+O).  

 

a    

Snapshot Pane: Automatin g Your Racks 

Snapshots contain the following parameters: 

Rack input and output gain 

Rack in/out, mute and on/off states 

in parameters 

Snapshots are contained and saved as part of the Session file and are displayed as a 

e Snapshots to change the state of racks (Mute/In/Off), levels, and, most importantly, 

Snapshots do not change the physical configuration of 

Session, so you cannot use a snapshot to change the audio I/O, the rack order or t

 

To open the Snapshot Pane (fig. a), select Open Snapshot Pane  from the 

b 

Snapshots are contained and saved as part of the Session file and are displayed as a 

acks (Mute/In/Off), levels, and, most importantly, 

Snapshots do not change the physical configuration of a 

ack order or the 

from the Window  

 



 

To save a Snapshot of your existing rack environment, use the console’s snapshot 

management  window (fig. b) (add Waves to the snapshot’s scope).  

MultiRack’s snapshots are given the name of their corresponding SD snapshot. 

 

 

Note that selected snapshots are highlighted and the currently recalled snapshot’s 

name appears in boldface  and its number is highlighted in green. At the bottom of the 

pane is an area where you can write notes about the selected Snapshot. 

 

 



Global Paste and Recall Safe modes

 

There are times when you don’t want certain racks or specific plug

Snapshot changes and there are times that you wish to apply a setting of 

rack across several snapshots.

The Global Paste  and Recall Safe

 

Global Paste 

 

"Global Paste " enables you to copy a plug

other snapshots. This is useful when you’ve set up several 

you decide to change plug-ins settings across several Snapshots. 

 

1. Recall the snapshot from which you want to copy settings.

 

2. Touch the Global Paste “

 

 

 

 

Global Paste and Recall Safe modes  

There are times when you don’t want certain racks or specific plug-ins to be affected by 

changes and there are times that you wish to apply a setting of 

napshots. 

Recall Safe  are the tools that provide you that ability.

les you to copy a plug-in’s or rack’s parameters into one or more 

napshots. This is useful when you’ve set up several racks filled with plug

ins settings across several Snapshots.  

Recall the snapshot from which you want to copy settings. 

the Global Paste “On” button.  

 >   

ins to be affected by 

changes and there are times that you wish to apply a setting of a plug-in or 

are the tools that provide you that ability. 

parameters into one or more 

acks filled with plug-ins and 

 



3. Select the target s napshot

snapshots, 

Ctrl+Click on the desired target 

contiguous snapshots (

4. In the rack windows, select the plug

selected snapshots to. Right

in/Rack  from the menu or touch the “

plug-ins or Racks whose setti

5. Touch the Global Paste button “

mode off and end the process.

 

Recall Safe 

 

"Recall Safe"  Mode allows you to select the 

affected as you change snapshots that would normally affect them. The recall

option applies within the session (not a specific 

 

 

Turn Recall Safe Mode “On” in the Snapshots Pane 

 

 

napshot /s that you want to modify. To select multiple 

+Click on the desired target snapshots, or Shift+Click to select several 

(using a mouse). 

ack windows, select the plug-in or rack to which want to copy to the 

. Right-click on the plug-in and choose Global Paste Plug

from the menu or touch the “Apply ” button. Repeat this for each of the 

ins or Racks whose settings you want to Global Paste.  

Touch the Global Paste button “On” in the snapshot Pane once again to turn this 

mode off and end the process. 

Mode allows you to select the racks and/or plug-ins that won’t be 

napshots that would normally affect them. The recall

ession (not a specific snapshot).  

” in the Snapshots Pane  

 >   

that you want to modify. To select multiple 

napshots, or Shift+Click to select several 

want to copy to the 

Global Paste Plug -

” button. Repeat this for each of the 

napshot Pane once again to turn this 

ins that won’t be 

napshots that would normally affect them. The recall-safe 

 



Racks : Select a Rack or multiple racks you want to set to Recall Safe.

button or Right click on any of the selected Racks and choose 

pull-down menu. "Recall Safe

 

 

 

 

 

Plug-ins: Select the plug-in you want to set to Recall Safe. Touch the “

Right click on any of the selected plug

menu. "Recall Safe" plug-ins glow blue:

 

 

To remove a rack or plug-in from 

in and touch the “Unset ” button or 

menu in Recall Safe  mode. 

Plug-ins or racks that are set to 

Safe" status can be viewed only while in 

the Snapshots menu does not activate or de

allows you to see plug-ins and 

"Recall Safe" mode off, racks and plug

they just don’t glow blue. 

When a rack is "Recall Safe", all the plug

effectively "Recall Safe" as well.

: Select a Rack or multiple racks you want to set to Recall Safe. Touch the “

button or Right click on any of the selected Racks and choose Recall Safe

Recall Safe" racks glow blue: 

in you want to set to Recall Safe. Touch the “Set

ny of the selected plug-ins and choose Recall Safe  from the pull

ins glow blue: 

in from "Recall Safe" mode, select the respective 

” button or de-select "Recall Safe" from the right click pull

acks that are set to "Recall Safe" can be edited. However, their 

status can be viewed only while in "Recall Safe" mode. Selecting "Recall Safe

the Snapshots menu does not activate or de-activate "Recall Safe". Rather, it only 

ins and racks, and set them to "Recall Safe". When you turn 

acks and plug-ins which have been "Recall Safe

, all the plug-ins within that rack are affected, i.e. are 

as well. 

Touch the “Set” 

Recall Safe  from the 

Set” button or 

from the pull-down 

 

mode, select the respective rack or plug-

from the right click pull-down 

can be edited. However, their "Recall 

Recall Safe" in 

. Rather, it only 

. When you turn 

Recall Safe" remain so; 

ack are affected, i.e. are 



Saving in MultiRack SoundGrid 

MultiRack SoundGrid offers four different levels of “Save,” enabling you to quickly and 

confidently store and recall needed Session information. From most specific to most 

general, here are your options for saving information: 

 

Per Plug-in:  Each plug-in has its own WaveSystem Toolbar, so you can load and save 

your favorite plug-in settings without affecting the rest of the processing environment. 

Say you have a C4 preset that you’d like to use for the bass. Simply load the preset 

from the C4’s WaveSystem Toolbar’s Load menu.  

Plug-in settings can be saved to an external USB key and loaded on to another console, 

given that the same plug-ins are installed and authorized on both consoles. 

 

Per Rack:  There’s a WaveSystem Toolbar at the top of each rack, so you can load and 

save settings for an entire Rack, independent of the Snapshots.  

Plug-in settings can be saved to an external USB key and loaded into another console, 

given that the same plug-ins are installed and authorized on both consoles. 

 

Sessions  hold the settings for every plug-in and all racks. MultiRack Sessions are 

saved alongside the console’s Session file; both files are named identically and are 

loaded in synchronization when the corresponding console Session file is loaded. 

 

Snapshots  hold the settings for every plug-in and rack, and contain the information 

about the architecture and signal flow for the entire setup. Snapshots are created and 

stored on the console main Snapshot window. 

 

The chart below illustrates the relationship between Functions and 

Snapshots/Presets/Session management – within the Waves MultiRack and DigiCo 

system. 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Overview Window:  

Viewing the Status of All of Your Racks 

Once you’ve filled several racks, you’ll want a convenient way to keep track of 

everything happening within your processing environment. To get an overview of your 

racks, select Overview  from the View menu. This will reveal the Overview Window, 

where you’ll see a condensed view of each Rack.  

 

The Overview Window tells you if a rack or an individual plug-in is functioning, and it 

enables you to turn on or off, bypass, or mute a Rack. Clipping is also indicated for each 

Rack. 

Use the Overview Window when you want to keep an eye on the entire processing 

setup. Since each mini-Rack in the Overview Window displays clipping information, you 

can easily watch out for over-level clipping across your entire setup. 



Show Mode 

 

              

 

 

Show Mode is a “safe mode,” used during performances, that lets you adjust 

parameters within plugins, but not change routing, configuration, and other settings that 

could cause problems in a live situation. 

 

When Show  is selected you’re locked out from mu

 

To Switch between Setup and Show modes, go to the 

>Security  and switch between 

 

 

   >   

 

When choosing Setup , MultiRack will switch to Setup mode, 

MultiRack will switch to Show Mode.

                             

Show Mode is a “safe mode,” used during performances, that lets you adjust 

parameters within plugins, but not change routing, configuration, and other settings that 

could cause problems in a live situation.  

is selected you’re locked out from much of the interface. 

To Switch between Setup and Show modes, go to the Master view- >System tab

and switch between Setup and Live . 

, MultiRack will switch to Setup mode, when choosing 

Show Mode. 

Show Mode is a “safe mode,” used during performances, that lets you adjust 

parameters within plugins, but not change routing, configuration, and other settings that 

>System tab -

 

hen choosing Live , 



Automatic Recovery

As MultiRack SoundGrid is an application for live 

automatic recovery mechanism. This means that if MultiRack SoundGrid quits 

unexpectedly, it will automatically re

running when it crashed, with the same 

occurred (if applicable). While MultiRack SoundGrid re

processing audio continues without interruption; only user control is 

SoundGrid re-loads its Session.

 

Rescan Present Licenses

 

If you are preparing a setup and routing without licenses (

flash drive or iLok key); the plug

won’t process audio you can still assign inserts, FX, load plug

 

To enable a disabled plug-in or plugins:

• Connect your USB Flash Drive (V9) and/or iLok key (V8).

• Go to Advanced Menu and select the “

All disabled plugins will be enabled.

• You can re-enable plugins individually by right clicking on disabled 

choosing enable  option from the menu.

 

 

 

 

 

Automatic Recovery  

As MultiRack SoundGrid is an application for live shows, it is equipped with an 

automatic recovery mechanism. This means that if MultiRack SoundGrid quits 

unexpectedly, it will automatically re-launch and re-open the same session file it was 

running when it crashed, with the same snapshot that was recalled when the crash 

While MultiRack SoundGrid re-launches itself, streaming and 

processing audio continues without interruption; only user control is lost until MultiRack 

loads its Session. 

Rescan Present Licenses  

 

up and routing without licenses (i.e. without a connected USB 

); the plug-ins will load in a disabled state. While the plug

won’t process audio you can still assign inserts, FX, load plug-ins and presets. 

or plugins: 

Connect your USB Flash Drive (V9) and/or iLok key (V8). 

Menu and select the “Rescan Present Licenses

plugins will be enabled. 

enable plugins individually by right clicking on disabled 

option from the menu. 

, it is equipped with an 

automatic recovery mechanism. This means that if MultiRack SoundGrid quits 

ession file it was 

napshot that was recalled when the crash 

launches itself, streaming and 

lost until MultiRack 

i.e. without a connected USB 

ins will load in a disabled state. While the plug-ins 

ins and presets.  

Rescan Present Licenses ”. 

enable plugins individually by right clicking on disabled plug-in and 



Restructuring a DiGiCo session to 96 kHz

Prior to restructuring a DiGiCo session to 96 kHz, you must 
SoundGrid® Server. 

System Monitor Window

Redundancy    Displays redundancy status.

 

Network   Displays network transport load. High loads may result in 

audio drops.

Processing/Redundant Server

• Device  – Device name

• Status  – Server status (online or offline)

• CPU Peak and average loads (

server. High loads may 

 

I/O Device 1 and 2 (if available)

• Device  – Device name

• Status  – Device status

Restructuring a DiGiCo session to 96 kHz  

Prior to restructuring a DiGiCo session to 96 kHz, you must disconnect your 

System Monitor Window  

Open this window from the Window menu.

This window displays real time status info on your 

SoundGrid network, I/O devices, and Servers.

 

 

 

 

 

 

 

 

 

 

isplays redundancy status. 

isplays network transport load. High loads may result in 

audio drops. 

Processing/Redundant Server  

Device name 

Server status (online or offline) 

and average loads (AVR) – Displays the load on the processing 

server. High loads may result in audio drops. 

(if available)  

Device name 

Device status 

disconnect your 

Open this window from the Window menu. 

This window displays real time status info on your 

SoundGrid network, I/O devices, and Servers. 

isplays network transport load. High loads may result in 

Displays the load on the processing 



MultiRack SoundGrid Keyboard Shortcuts 
 

If you are using an external keyboard you may want to get familiar with MultiRack’s 

keyboard shortcuts. 

 

Session Item Definition  Keyboard shortcut  

Import  session  Opens explorer window,  import session  Ctrl+Alt+I  

Export session  Opens explorer, export session  Ctrl+Alt+E  

 

Window Item  Definition  Keyboard shortcut  

Open Snapshot Pane  Opens/closes the Snapshot Pane in MultiRack 

SoundGrid window. 

F7 

SoundGrid Inventory  Opens the SoundGrid Inventory Window  F2 

SoundGrid 

Connections 

Opens the SoundGrid Connections Window  F3 

Group Properties …  Opens the Group Properties window  Ctrl+G  

System Monitor  Opens the System Monitor window  Ctrl+M  

Preferences  Opens the Preferences window  Ctrl+P  

 

Menu Item  Definition  Keyboard shortcut  

Main view  Mode Opens the main application view (multiple Racks)  F4 

Overview Mode  Opens the overview view  F5 

Rack view  Mode Opens the Rack view  F6 

   

Advanced Item  Definition  Keyboard shortcut  

Enable Verbose mode  Creates Log file for troubleshooting.   

Rescan Present 

Licenses 

Starts rescan of licenses on connected iLok (v8) 

and/or USB Flash Drive (V9) . 

Ctrl + L  

 

 


